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         Twin Tec User Instructions for 
PC Link TCFI IID Software 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING.  
NOT LEGAL FOR USE OR SALE ON POLLUTION CONTROLLED VEHICLES. 

OVERVIEW 
PC Link TCFI IID software runs under Microsoft 

Windows 98/ME/XP/Vista. The TCFI IID version of PC 
link software allows the user to program the new TCFI 
IID version of our fuel injection controller for Twin-Cam 
series engines with custom ignition and fuel tables and 
other engine parameters. The term TCFI is used 
throughout this document as a generic term and 
refers to the new TCFI IID version unless otherwise 
noted. 

An optional USB Interface or PC link cable is 
required to connect to the existing four terminal 
Deutsch style data link connector on the H-D wiring 
harness.  

The new Twin Tec USB Interface P/N USB-INTF 
provides PC connectivity for all of our engine controls 
(ignition and fuel injection systems) and eliminates the 
requirement for multiple cables or a separate USB 
adapter if your laptop is not equipped with an RS-232 
serial port (9 pin male D-sub connector). The USB 
Interface is compatible with Windows 98/ME/XP/Vista.  

If you do not have the new USB interface, you 
will require the original RS-232 PC link cable P/N 
TCFI-C also used with our new TC88A ignition. Please 
note that the TC88C PC link cable used with the earlier 
TC88 ignition will not function. The two types of PC link 
cables have identifying labels, but otherwise appear 
similar. However, the electrical connections are 
different and the two cables types cannot be 
interchanged. 

After PC Link TCFI IID is launched, the main 
screen appears blank. You have two options for 
obtaining data for editing. You can open a previously 
saved data file by using the Open File command on the 
File menu or you can download data from an attached 
TCFI unit by using the Download Data From TCFI 
command on the Communications menu. Note that 
TCFI data files use a .dat extension. You should create 
a separate folder to store these files.   

Once you have TCFI data, you can edit various 
2D and 3D tables and engine parameters. All 3D tables 
are accompanied by chart displays that help visualize 
the data. You can also rotate the 3D chart display for a 

better view of a particular region. You can print the 
data associated with an active table or engine 
parameters by using the appropriate Print command 
from the File menu. When you open a file or download 
data from a TCFI module, the data is stored in a buffer 
memory. After editing a table, you can save the edits to 
this buffer memory. Once you have completed all your 
edits, you can save the data in buffer memory to a file or 
upload it back to the TCFI module by using the appropriate 
command from the File or Communications menu.  

PC Link TCFI IID version 10.0 is only compatible 
with TCFI IID units with firmware revision 7.0 and 
higher. Files created with the original PC Link TCFI 
software and earlier versions of PC Link TCFI IID are 
automatically converted to the new file format when 
opened, however several tables and parameters must 
be edited. Please refer to the TCFI IID Tuning Manual 
and TCFI IID Rev 7.0 Firmware Update Tech Note for 
details before attempting to use old files.  

TCFI SETUP 
The TCFI requires setup, using PC Link TCFI 

IID software, before running the engine for the first 
time. Setup establishes module parameters such as 
engine displacement and injector size and appropriate 
ignition and fuel control tables. You should carefully 
read this entire instruction manual before proceeding. 
Please refer to the TCFI IID Tuning Manual for 
detailed setup and tuning instructions. 

Setup data files are provided in the program 
folder for typical engine applications. Refer to the TCFI 
IID Tuning Manual for details.  

PC REQUIREMENTS 
If you are using the new Twin Tec USB Interface 

(P/N USB-INTF), refer to the supplied instructions for 
details. No additional hardware is required.  

The original PC link cable connects to an RS-
232 serial port by means of a female 9 pin D-sub 
connector. Data transfer occurs at 56 kBaud. The high 
baud rate limits the maximum cable length and the use 
of an extension cable is not recommended. Due to the 
cable length limitation and the need for portable 
access, a laptop PC is recommended. The PC must 
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have a free serial port (COM1-255) with a standard 9 
pin male D-sub connector. If your laptop does not 
include a serial port, you can use a USB adapter. 
However, not all USB adapters will work correctly with 
our PC link cables. Most of the inexpensive USB 
adapters are intended for interfacing Palm Pilot type 
devices and do not support all the signals required by 
our PC link cables.  

We sell and recommend a low cost USB adapter 
(P/N USBG-232) that has been tested with a wide 
range of system configurations. The USBG-232 
adapter comes with correct and updated driver files on 
CDROM. After installation the USBG-232 adapter will 
usually appear as COM5. 

We recommend a laptop with Pentium processor 
and super VGA display (SVGA with 1024 x 768 pixel 
resolution) running Windows 98/ME/XP/Vista. Data 
chart display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading. 

PC Link TCFI IID includes print commands that 
print table graphics and other engine parameters. The 
program has been tested with Hewlett-Packard laser 
and inkjet printers and Epson inkjet printers. We 
recommend using a color inkjet printer.   

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair. Since Windows 
98 systems did not originally include the Windows 
Installer service, the required installer software is 
included in the distribution media.  

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's Tech FAQ for details. 

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in 
the PC_Link_TCFI2D folder on the CDROM or the 
setup.exe file downloaded from our website. 
InstallShield will install the software in an appropriate 
folder under Program Files. 

Once InstallShield has completed the 
installation, PC Link TCFI IID will appear on the 
Windows Start Menu. You can then launch it just as 
you would any other Windows program.  

PC Link TCFI IID requires the Monospace 821 
BT fixed pitch printer font in order to properly align 
columns when printing advance tables. The 
Monospace 821 BT font is included in the distribution 
media and automatically copied to your Windows Fonts 
folder during installation. A backup copy is also placed 
in the program folder. If you accidentally delete this 
font, use the Install New Font command from the Fonts 
folder File menu. The filename associated with 
Monospace 821 BT is monos.ttf. 

DOWNLOADING DATA  
If you are using the new USB Interface, refer to 

the supplied instructions for details. No additional 
hardware is required.  

If you are using the original RS-232 PC link 
cable, connect the cable to the OE data link connector 
and PC serial port. The OE data link uses a four 
terminal Deutsch connector that is usually found near 
the TCFI unit.  

Turn the ignition key and engine run/stop 
switches on to provide power to the TCFI unit. Do not 
start the engine. 

If the TCFI unit has been removed from the 
motorcycle, you can do bench top programming by 
using an adapter harness (P/N TCFI-ADAPT) that 
includes a small 12 volt DC power supply.  

COM1 is used as the default port. If you are 
using a different COM port, use the Port Setup 
command on the Communications Menu. 

Download data by using the Download Data 
From TCFI command on the Communications menu. 
The program will display the module's firmware ID.  

Data downloaded from earlier TCFI units is 
automatically converted to the new format. This 
allows downloading and saving data when 
updating a TCFI II unit with the new TCFI IID 
firmware, however, several tables and parameters 
must be edited. Please refer to the TCFI IID Tuning 
Manual and TCFI IID Rev 7.0 Firmware Update Tech 
Note for details before attempting to use or save 
old data.   
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CREATING A NEW IGNITION 
ADVANCE TABLE  

Use the New Advance Table command on the 
Edit, Edit 3D Table, Advance Table menu. A dialog box 
appears and allows you to enter initial timing and 
advance slope settings. Settings close to 5 result in an 
advance table suitable for stock engines. Use lower 
values for high compression engines. Each time you 
click on Update, the corresponding advance table is 
displayed.  

Figure 1 - Creating a New Advance Table 

 
 

You will find the New Advance Table command 
useful for generating an advance table that will serve 
as a starting point for further edits. When you are ready 
to proceed with editing, click on OK. After you have 
edited the table, you must use the Save Table Edits To 
Buffer command from the Edit menu to save your edits 
to buffer memory. If you use the Close Table command 
from the Edit menu, all your edits are lost.   

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down.  

Figure 2 – Modify Command  

 

You can also use the Modify command on the 
pop-up menu. When you enter a value, the presence of 
optional sign (+ or -) or percent (%) characters affects 
the outcome of the Modify command.   

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link TCFI IID is intended to be an open 
system and uses the Component One Chart 7.0 3D 
charting control. The adventurous user can experiment 
with the chart property pages by right clicking on the 
chart. Almost any chart property can be changed. Click 
on the Help button for more information. If you corrupt 
the chart, exit and restart PC Link TCFI IID.  

Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 3D table 
data to or from another application such as Microsoft 
Excel. Arrange the program windows so that both the 
source and destination are visible (one on the left side 
of the screen and the other on the right side seems to 
work best). You must be able to see the information 
you want to drag as well as the location where you 
want to drop it. To export from PC Link TCFI IID to 
Excel, use the left mouse button to select a range of 
data on the spreadsheet grid. Then move the mouse 
cursor to an edge around the selection. Hold the left 
mouse button down and drag the selection into Excel. 
Release the left mouse button on the top left cell in 
Excel. When importing into PC Link TCFI IID from 
Excel, use the same procedure, except that Excel 
requires dragging and dropping with the right mouse 
button.   

EDITING IGNITION ADVANCE TABLE 
DATA  

Once you have advance table data (by opening 
an existing data file, downloading data from a TCFI unit 
or creating a new table as explained in the previous 
section), you can edit the data by clicking on and 
dragging individual points on the 3D chart display or 
you can directly edit numeric data on the spreadsheet 
grid.  

The table consists of 20 columns from zero to 
7,500 RPM and 8 manifold pressure (MAP) rows from 
16 to 30 In-Hg. The 7,500 RPM advance value is used 
at all higher RPM levels and the 16 In-Hg MAP 
advance value is used at all lower MAP levels. Note 
that 16 In-Hg corresponds to a high vacuum 
deceleration or idle condition and that 30 In-Hg 
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corresponds to wide open throttle (WOT).  Advance 
values must be between zero and 45 degrees. 

You can shift the entire advance table up or 
down by holding the Shift key down while dragging any 
point. The chart label box shows the shift in degrees. 
When you release the mouse button, the chart and 
spreadsheet grid values will be updated. Response of 
the chart label box may be sluggish on slower systems 
due to the amount of data being updated.  

After you have edited the table, you must use 
the Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost.   

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 2.   

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

Figure 3 – Editing Advance Table Data 

PC Link TCFI IID is intended to be an open 
system and uses the Component One Chart 7.0 3D 
charting control. The adventurous user can experiment 
with the chart property pages by right clicking on the 
chart. Almost any chart property can be changed. Click 

on the Help button for more information. If you corrupt 
the chart, exit and restart PC Link TCFI IID.  
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Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 3D table data 
to or from another application such as Microsoft Excel. 
Arrange the program windows so that both the source 
and destination are visible (one on the left side of the 
screen and the other on the right side seems to work 
best). You must be able to see the information you 
want to drag as well as the location where you want to 
drop it. To export from PC Link TCFI IID to Excel, use 
the left mouse button to select a range of data on the 
spreadsheet grid. Then move the mouse cursor to an 
edge around the selection. Hold the left mouse button 
down and drag the selection into Excel. Release the 
left mouse button on the top left cell in Excel. When 
importing into PC Link TCFI IID from Excel, use the 
same procedure, except that Excel requires dragging 
and dropping with the right mouse button.  

EDITING 3D TABLE DATA  
In addition to the ignition advance table, there 

are five other 3D tables that you can edit: AFR (air/fuel 
ratio), Alpha-N (throttle position and RPM based fuel 
table), front cylinder trim (percent fuel trim for front 
cylinder), and front and rear BLM (block learn 
multiplier). Before you can edit one of these tables you 
must either open a data file or download data from a 
TCFI unit. Due to the somewhat irregular shape of 
these tables, editing data by clicking on and dragging 
points on the chart is not feasible. You must edit the 
numeric data on the spreadsheet grid. 

Each table consists of 20 columns from zero to 
7,500 RPM and 11 throttle position rows from 0% to 
100%. The 7,500 RPM value is used at all higher RPM 
levels.

Figure 4 – BLM Table Showing Special Cells 
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After you have edited a table, you must use the 
Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost.   

Alpha-N Table 
The Alpha-N table is the main fuel table (Alpha-

N is the technical term for throttle position and RPM). 
The Alpha-N table values are in percent units. The 
calculated base injector pulse width (determined by 
engine horsepower and injector size settings on the 
module parameters screen) is multiplied by the Alpha-
N table value to determine the theoretical injector pulse 
width for a 14.7 air fuel ratio. This value is then 
corrected for the desired air/fuel ratio (as set on the 
AFR table) and BLM (block learn multiplier) to arrive at 
the actual rear injector pulse width.  

From a practical standpoint, the Alpha-N table 
must be within about ±20% of the required values for 
the TCFI system to successfully correct the injector 
pulse width based on closed loop feedback from an 
exhaust gas oxygen sensor.   

AFR Table 
The AFR (air/fuel ratio) table sets the desired 

air/fuel ratio under various operating conditions. The 
air/fuel ratio value is used in the rear injector pulse 
width calculation as explained above. Typical air/fuel 
ratios are 13.0 for idle, 13.8 for cruise, and 12.8 for 
wide open throttle. To prevent engine overheating, 
avoid lean air/fuel ratios exceeding 14.5 under cruise 
conditions. 

Front Cylinder Trim Table 
The front cylinder trim table values are in 

percent units. The calculated injector pulse width is 
multiplied by the front cylinder trim value to arrive at 
the front injector pulse width. Required front cylinder 
trim values are dependent on engine gas flow 
dynamics. The front cylinder trim table is automatically 
corrected when the Apply Front BLM Table command 
is executed. Please refer to the TCFI IID Tuning 
Manual for more information about front cylinder 
trim and fuel injector sizing. If you exceed the 
horsepower limits listed in Table 1 of the TCFI IID 
Tuning Manual, front cylinder trim may fail. 

BLM Table 
The rear BLM (block learn multiplier) table is 

shown in the graphic above. BLM values are in percent 
units and represent a correction factor required to 
obtain the air/fuel ratio set on the AFR table. BLM 

values are updated based on closed loop feedback 
from the exhaust gas oxygen sensor.  

Some special considerations apply to the BLM 
tables. BLM values are limited in range from 75% to 
125%. The range limits are set on the module 
parameters screen. When a BLM cell nears the range 
limit, the cell color changes to red to alert the user that 
the system has just about run out of correction range 
and that the corresponding cell in the Alpha-N fuel 
table must be changed.   

BLM cell values 0 and 1 command special 
functions and these cells are highlighted in blue. 
Closed loop feedback is disabled in any BLM cells with 
value 0. This is useful in operating areas where 
exhaust reversion effects may cause incorrect sensor 
readings. Note that most BLM tables will have the 
value 0 in cells corresponding to decel (RPM above 
idle and closed throttle) where reversion effects are 
most pronounced.  

BLM update, but not closed loop feedback, is 
disabled in any BLM cells with value 1. Some BLM 
tables may have the value 1 in cells corresponding to 
idle (1000-1250 RPM and closed throttle). Please refer 
to the TCFI IID Idle Tuning Tech Note for more 
information on this subject.  

After several hours of engine operation, examine 
the BLM (block learn multiplier) tables. If you see red 
cells on a BLM table, you can use the corresponding 
Apply BLM Table command (on the BLM Table 
submenu) to automatically correct the Alpha-N fuel 
table and front cylinder trim table. After running the 
Apply BLM Table command, the BLM table cells will 
return to 100%. Please remember to upload the data 
back to the TCFI unit in order for the changes to take 
effect. 

The Reset BLM Table command on the BLM 
Table submenu resets all BLM cells to 100%. 

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 2.   
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Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link TCFI IID is intended to be an open 
system and uses the Component One Chart 7.0 3D 
charting control. The adventurous user can experiment 
with the chart property pages by right clicking on the 
chart. Almost any chart property can be changed. Click 
on the Help button for more information. If you corrupt 
the chart, exit and restart PC Link TCFI IID.  

Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 3D table data 
to or from another application such as Microsoft Excel. 
Arrange the program windows so that both the source 
and destination are visible (one on the left side of the 
screen and the other on the right side seems to work 
best). You must be able to see the information you 
want to drag as well as the location where you want to 
drop it. To export from PC Link TCFI IID to Excel, use 
the left mouse button to select a range of data on the 
spreadsheet grid. Then move the mouse cursor to an 
edge around the selection. Hold the left mouse button 
down and drag the selection into Excel. Release the 
left mouse button on the top left cell in Excel. When 
importing into PC Link TCFI IID from Excel, use the 
same procedure, except that Excel requires dragging 
and dropping with the right mouse button. 

EDITING 2D TABLE DATA  
There are eleven 2D tables that you can edit. 

Before you can edit one of these tables you must either 
open a data file or download data from a TCFI unit. 
Each table consists of 17 columns with the upper row 
corresponding to the independent variable (throttle 
position, engine temperature, elapsed time, or IAC (idle 
air control) position. You can edit the numeric data 
corresponding to the dependent variable on the lower 
row of the spreadsheet grid. A typical 2D table is 
shown below. Some of the engine temperature cells 
are highlighted in red. These red cells correspond to 
invalid sensor readings.  

After you have edited the table, you must use 
the Save Table Edits To Buffer command from the Edit 
menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost.   

TPS Transfer Function Table 
This table determines the relationship between 

TPS sensor volts and TPS percent used in various 3D 
tables such as the Alpha-N table. Note that the table 
starts at .39 volts, which is the nominal TPS sensor 
output with the throttle closed at idle. Some aftermarket 
throttle bodies, such as the S&S Cycle VFI Induction 
System, do not use a standard Delphi throttle sensor 
and thus require a different TPS transfer function. The 
provided setup files have the proper TPS transfer 
function and you should never change these 
values unless given specific instructions from tech 
support. 

Delta TPS Fuel Multiplier Table 
This table consists of a fuel multiplier (percent 

units) that is a function of delta throttle position. Delta 
throttle position means change in throttle position. Fuel 
multipliers greater than 100% for positive delta throttle 
position correspond to an acceleration enrichment 
(similar effect to an accelerator pump on a carburetor). 
Fuel multipliers less than 100% for a negative delta 
throttle position correspond to a deceleration 
enleanment (useful for reducing exhaust back fire).  

IAC Based TPS Adder Table 
This table consists of a throttle position factor 

corresponding to IAC position. In an Alpha-N fuel 
control, IAC position must be considered. A high IAC 
position (high idle air flow) is the same as opening the 
throttle. In general the values in this table need only be 
edited if an aftermarket throttle body with significantly 
greater air flow is used. In this case, the table values 
should be reduced slightly.  

 

 

 

Figure 5 – Typical 2D Table 
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ET Based Priming Fuel Table 
This table consists of an injector pulse width that 

is a function of engine temperature. The priming pulse 
occurs once on the initial ignition switch on event. 
Some of the engine temperature cells are highlighted 
in red. These red cells correspond to invalid sensor 
readings.  

ET Based Cranking Fuel Table 
This table consists of an injector pulse width that 

is a function of engine temperature. The cranking pulse 
width is used during engine start. Some of the engine 
temperature cells are highlighted in red. These red 
cells correspond to invalid sensor readings.  

Time Based AFR Cold Start Enrichment 
Table 

This table consists of an AFR cold start 
multiplier (percent units) that is a function of elapsed 
time since engine start. This AFR cold start enrichment 
is applied to the values in the 3D AFR table. The AFR 
values are multiplied by the time based AFR cold start 
enrichment and by the ET based AFR cold start 
enrichment. For example, assume that the AFR value 
in a given cell is 14.0 and that the time and ET based 
AFR cold start enrichment values are 50% and 15% 
respectively. The actual AFR value for that cell then 
becomes 13.0  (14/(1 + 0.5 x 0.15)). The time based 
AFR cold start enrichment should always taper off from 
100% at zero elapsed time and must reach 0% at the 
maximum value of elapsed time (251 seconds). In 
general, the values in this table will be correct for most 
applications and should not be changed without 
consulting tech support. 

ET Based AFR Cold Start Enrichment 
Table 

This table consists of an AFR cold start 
multiplier (percent units) that is a function of engine 
temperature. This table does double duty for hot soak 
enrichment. Some of the engine temperature cells are 
highlighted in red. These red cells correspond to invalid 
sensor readings. In general, the values in this table will 
be correct for most applications and should not be 
changed without consulting tech support. 

Time Based Fuel Cold Start Enrichment 
Table 

This table consists of a fuel cold start multiplier 
(percent units) that is a function of elapsed time since 
engine start. The overall fuel cold start enrichment is 
determined as follows: calculated injector pulse width 
for each cylinder is multiplied by the time based fuel 
cold start enrichment and by the appropriate ET based 

front or rear cylinder cold start enrichment. The overall 
fuel cold start enrichment is then added to the injector 
pulse width. For example, assume that the calculated 
injector pulse width is 4 msec and that the time and ET 
based fuel cold start enrichment values are 50% and 
25% respectively. The total injector pulse width is then 
4.5 msec (0.5 x 0.25 x 4.0 + 4.0). The time based fuel 
cold start enrichment should always taper off from 
100% at zero elapsed time and must reach 0% at the 
maximum value of elapsed time (251 seconds). 

ET Based Front and Rear Cylinder Cold 
Start Enrichment Table 

These tables consist of a fuel cold start fuel 
multiplier (percent units) that is a function of engine 
temperature. Individual tables are used because most 
engines exhibit significant differences in the 
characteristics of the front and rear cylinders. These 
tables also do double duty for hot soak enrichment. 
Note that a significant enrichment is required at high 
temperatures due to reduced injector flow. Some of the 
engine temperature cells are highlighted in red. These 
red cells correspond to invalid sensor readings. You 
may need to edit these two tables for optimum cold 
start and restart after hot soak. Please refer to the 
TCFI IID Tuning Manual and TCFI IID Idle Tuning 
Tech Note for more information on this subject. 

ET Based Idle RPM Table 
This table consists of desired idle RPM as a 

function of engine temperature. The ET based IAC 
position (see table description above) is adjusted to 
maintain the desired idle RPM. Some of the engine 
temperature cells are highlighted in red. These red 
cells correspond to invalid sensor readings.  

ET Based IAC Position Table 
This table consists of IAC (idle air control) 

position as a function of engine temperature. Greater 
IAC values result in more idle air and higher idle 
speed. IAC position is continuously reduced as the 
engine warms up, even if the engine is not idling. 
Some of the engine temperature cells are highlighted 
in red. These red cells correspond to invalid sensor 
readings.  

ET Based IAC Start Adder Table 
This table consists of IAC (idle air control) 

position as a function of engine temperature. The 
values represent additional air flow through the idle 
system during engine starting. Generally, more air is 
required for a hot start, especially after a hot soak. 
Some of the engine temperature cells are highlighted 
in red. These red cells correspond to invalid sensor 
readings. 
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Time Based IAC Start Adder Table 
This table was added in Version 7.0. The table 

consists of a multiplier factor (percent units) that is a 
function of elapsed time since engine start. The 
multiplier factor is applied to the IAC start adder in 
order to compensate for time dependent characteristics 
of the throttle body after engine start, especially after a 
hot soak. The table values should always taper off from 
some initial value at zero elapsed time and must reach 
0% at the maximum value of elapsed time (268 
seconds). If the engine runs above the desired idle 
RPM for several seconds when first returning to idle 
after the motorcycle has been driven some distance, a 
higher initial multiplier value is required.  

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 2.   

Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 2D table data 
to or from another application such as Microsoft Excel. 
Arrange the program windows so that both the source 
and destination are visible (one on the left side of the 
screen and the other on the right side seems to work 
best). You must be able to see the information you 
want to drag as well as the location where you want to 
drop it. To export from PC Link TCFI IID to Excel, use 
the left mouse button to select a range of data on the 
spreadsheet grid. Then move the mouse cursor to an 
edge around the selection. Hold the left mouse button 
down and drag the selection into Excel. Release the 
left mouse button on the top left cell in Excel. When 
importing into PC Link TCFI IID from Excel, use the 
same procedure, except that Excel requires dragging 
and dropping with the right mouse button.   

MODULE PARAMETERS  
Module parameters are divided into two 

categories: basic parameters and advanced 
parameters. Module parameters control the overall 
operation of the TCFI unit. Setup and calibration of the 
TCFI unit will generally involve editing some of the 
basic parameters. Users should not modify any of the 
advanced parameters without first consulting tech 
support. Basic module parameters are displayed in a 

dialog box by using the Edit Basic Module Parameters 
command on the Edit menu.  

Basic parameters include: 

Closed Loop AFR Control Mode – allows BLM 
(block learn multiplier) table updates based on 
feedback from an exhaust gas oxygen sensor. Only 
select this checkbox if the WEGO (wide-band exhaust 
gas oxygen) unit is connected to the TCFI. 

Dual Independent Runner Intake – you must 
select this checkbox if you are using a dual 
independent runner intake such as the BC Gerolamy 
Dual Flow or S&S Cycle VFI Induction System. With a 
standard Delphi intake system, the MAP sensor is 
sampled as each cylinder approaches BDC on the 
intake stroke. Dual independent runner intake systems 
have the MAP sensor connected to the front runner. 
When you select this checkbox, the MAP sensor is 
only sampled when the front cylinder approaches BDC 
on the intake stroke.  

Continuous Barometric Pressure Update 
Mode – recommended for operation in mountainous 
terrain with elevation changes of more than 3000 feet. 
Barometric pressure is continually estimated from 
manifold pressure sampled at specific crank angle and 
TPS conditions. Note: only supported on TCFI Gen II.  

Enable Low Fuel Warning – you should select 
this option for 2004-2008 models equipped with a 
speedometer that includes a low fuel warning LED.  

Automatic Nominal Idle IAC Update Mode – 
recommended for most applications. The nominal idle 
IAC value (IAC steps once engine is fully warmed up 
and at stable idle condition) is automatically sampled 
and updated. Manual setting of the nominal idle IAC 
value may be required for some applications. For more 
information on this subject, please refer to the TCFI IID 
Idle Tuning Tech Note. 

Anti-Stall IAC Mode – for problem applications 
where occasional engine stalling occurs when the 
clutch is pulled in. In anti-stall IAC mode, closed loop 
idle speed control is always active when engine RPM 
is below the target idle RPM. This may cause an 
unexpected increase in idle RPM if the engine is 
inadvertently “lugged” down below the target idle RPM. 
For more information on this subject, please refer to 
the TCFI IID Idle Tuning Tech Note. 

Estimated HP at 6000 RPM – enter a 
reasonable estimate in order for the TCFI to calculate 
the base injector pulse width. Well tuned engines will 
develop slightly over one horsepower per CID. If the 
horsepower peak is below 6,000 RPM, use the peak 
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value. Multiply rear wheel dyno horsepower by 1.1 to 
arrive at an estimated engine horsepower figure.     

Injector Size – flow rate in gm/sec units. Refer 
to Table 1 below. You must enter the correct injector 
size value in order for the TCFI to calculate the base 
injector pulse width. Injector size scaling has 
changed to accommodate the smaller injectors 
used in 2006 and later applications. If you load a 
setup file or download data created with an earlier 
version of PC Link TCFI, you must reenter the 
correct injector size and then save the file.  

 

 

 

Table 1 – Injector Size for 2001-2008 Models 

Model Injector Size (gm/sec) 

2001-2005 Stock Twin 
Cam 88 

4.22 

2006-2008 Stock Twin 
Cam 

3.91 

2006-2008 Screamin 
Eagle P/N 27654-06 

4.89 

Twin Tec TCFI-INJ-5S (fits 
2001-2005 only) 

6.00 

 

Figure 6 – Basic Module Parameters Dialog Box 

  
Base Injector Pulse Width – in millisecond 

units. Please note the base injector pulse width is a 
calculated value that you cannot directly edit.  

RPM Limit – you can enter any value from 
3,000 to 9,900 RPM. Values are automatically rounded 
to the nearest 100 RPM. 

 Cranking Revs - sets the number of engine 
revolutions before the ignitions fires the first spark. 
Most Twin-Cam engines will start best with a zero 
setting. Please note that a hot engine may exhibit 
preignition and appear to start on the first revolution 
even if the Cranking Revs parameter is set to a non-
zero value. 
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Rear Cylinder Timing Offset – you can set the 
value over a -5 to +5 degree range. Leave the value at 
zero if you do not require a rear cylinder timing offset.  

Data Logging Interval – you can set the 
interval from 0.1 to 1.0 seconds. TCFI data logging 
capacity is 1600 samples. An interval of 0.1 seconds 
allows the TCFI to store the last 2-1/2 minutes of 
operation. An interval of 1.0 seconds corresponds to 
about 26 minutes of data. For dyno testing, we suggest 
that you set the interval to 0.1 seconds. For testing at 
the race track, we recommend an interval in the 0.25 to 
1.0 second range. If you change the data logging 
interval, you should also run the TCFI Log program 
and clear the data buffer.  

VSS Frequency – this parameter sets the 
correct speedometer and odometer scaling. An 
incorrect value will also affect idle RPM control and 
turn signal cancellation. Please refer to the following 
section for more details. 

6th Gear Ratio – applicable to 2007-2008 
models only. This parameter sets the RPM/KPH ratio 
used to detect the transmission gear and illuminate the 
6th  gear light. You can use the gear ratio display 
function in TCFI Log software data logging chart 
display to determine the required value for a particular 
application. For 2001-2006 models, you can use the 
default value of 23.5. Please refer to the following 
section and the TCFI IID Tuning Manual for more 
details. 

WEGO Warmup Time – in seconds. This 
parameter determines the minimum engine run time 
before closed loop AFR control. 

Idle TPS – in percent units. This parameter 
determines the maximum TPS (throttle position sensor) 
value for closed loop idle speed control. The default 
value is 1.0%. Some throttle bodies may require a 
higher value for reliable idle speed control. For more 
information on this subject, please refer to the TCFI IID 
Idle Tuning Tech Note. 

Nominal Idle IAC steps – this parameter 
determines the nominal IAC (idle air control) stepper 
motor position. For more information on this subject, 
please refer to the TCFI IID Idle Tuning Tech Note. 

User Data – you can enter up to 32 characters 
of user data that will be saved in EEPROM memory. 
User data can contain comments or serial numbers. 

Once you have entered the appropriate module 
parameters, click on OK to save your edits to buffer 
memory. If you click on Cancel, all your edits are lost. 
You can click on Restore Defaults to restore default 
values for a stock Twin-Cam engine. 

Advanced module parameters are displayed in a 
dialog box by using the Edit Advanced Module 
Parameters command on the Edit menu. 

Advanced parameters include: 

Warm Engine Temperature – in degree C 
units. This parameter determines the minimum engine 
(cylinder head) temperature before closed loop 
corrections are saved to the BLM tables. The default 
value is 95 degree C. Engine status changes from cold 
to warm once the warm engine temperature is reached 
and the engine warmup time has elapsed.  

Engine Warmup Time – in seconds. This 
parameter determines the minimum engine run time 
before closed loop corrections are saved to the BLM 
tables. The default value is 260 seconds. Engine status 
changes from cold to warm once the warm engine 
temperature is reached and the engine warmup time 
has elapsed.  

Hot Soak Temperature – in degree C units. 
This parameter determines the minimum engine 
(cylinder head) temperature before special hot soak 
considerations apply when the engine is turned off. 
The default value is 60 degree C.  

Hot Soak Timeout – in seconds. This 
parameter determines the minimum engine off time 
(prior to a hot restart) before special hot soak 
considerations apply. The default value is 60 seconds.  

Delta TPS Gain – this parameter determines the 
scaling of TPS values in the delta TPS based fuel 
multiplier table. Do not change this parameter from the 
default value of 5.  

Enlean Decay Rate – this parameter 
determines the time constant of recovery from 
enleanment (negative delta TPS values) in the delta 
TPS based fuel multiplier table. Do not change this 
parameter from the default value of 25.  

Enrich Decay Rate – this parameter determines 
the time constant of recovery from enrichment (positive 
delta TPS values) in the delta TPS based fuel multiplier 
table. Do not change this parameter from the default 
value of 20.  

Minimum Injector Pulse Width – in millisecond 
units. This parameter affects linearity of the fuel tables 
at low values. Do not change this parameter from the 
default value of 0.1.  

Idle Integrator Gain – this parameter 
determines the response time of closed loop idle speed 
control. A higher value will result in a faster response 
but may cause instability (oscillation). The default value 
is 10. 
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Figure 7 – Advanced Module Parameters Dialog Box 

 
 

AFR Integrator Gain – this parameter 
determines the response time of closed loop AFR 
control. A higher value will result in a faster response 
but may cause instability (oscillation). The default value 
is 30. 

AFR Deadband – in AFR units. This parameter 
determines the deadband (minimum error before 
system response) for closed loop AFR control. A small 
deadband value improves closed loop stability and 
reduces hunting. The default value is 0.3. 

Min AFR BLM – in percent. This parameter 
limits the minimum BLM value when the system is 
correcting a rich condition. The default value is 75%. 

Max AFR BLM – in percent. This parameter 
limits the maximum BLM value when the system is 
correcting a lean condition. The default value is 125%. 

Asynchronous Fuel Gain – this parameter 
determines the amount of fuel that is immediately 
(asynchronously) injected when the throttle is rapidly 
opened. Higher values result in more fuel. A zero value 
disables asynchronous injection. 

 

 

 

SPEEDOMETER CALIBRATION  
For 2001-2003 models, the VSS scaling affects 

data displayed by TCFI Log and idle speed control. 
You must enter the value shown in Table 2 (used for all 
models). For 2004-2008 models with the instrument 
cluster on the SAE J1850 data bus, the VSS frequency 
parameter sets the correct speedometer and odometer 
scaling. You can find the exact value in the 
speedometer section of the factory service manual for 
your model. Use the frequency value at 100 KPH. 
Values for most 2004-2006 models are given in Table 
3. Preliminary values for 2007-2008 models are given 
in Table 4. For models not listed, you can use TCFI 
Log software to examine data logged while the 
motorcycle was operated at a known speed in 6th gear. 
Use the speedometer recalibration procedure as 
explained below to recalculate the VSS frequency. Use 
the gear ratio display function and average several 
readings to determine the 6th gear ratio.   

Table 2 – VSS Frequency at 100 KPH for 
2001-2003 Models 

Model  

All 2001-2003 155 Hz 
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Table 3 – VSS Frequency at 100 KPH for 
2004-2006 Models 

Model All exc. 
Japan 

Japan 
Only 

Sportster 883 1431 Hz 1635 Hz 

Sportster 1200 1386 Hz 1526 Hz 

Dyna (exc. 
FXDP) 

1424 Hz 1583 Hz 

Dyna FXDP 1435 Hz N/A 

Softail (exc. 
FXSTD) 

1403 Hz 1501 Hz 

Softail FXSTD 1382 Hz 1506 Hz 

Touring Models 
(exc. Police) 

1375 Hz 1493 Hz 

Touring Models 
(Police) 

1435 Hz 1435 Hz 

Table 4 – VSS Frequency and 6th Gear 
Ratio for 2007-2008 Models 

Model VSS Frequency 
at 100 KPH 

6th Gear Ratio 
(RPM/KPH) 

Softail 1460 Hz 23.5 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Speedometer Recalibration (for 2004-2008 
models only). You can easily recalibrate the 
speedometer (and odometer) to accommodate tire and 
gear changes. Run the motorcycle on a chassis dyno 
at a constant speed. Note the speedometer reading 
and the correct speed indicated on the dyno. Use the 
following formula to calculate the new VSS frequency 
parameter: 

New VSS Freq  =  Original VSS Freq x Speedo Reading                            
          Indicated Dyno Speed 

 

For example, if the original VSS frequency 
parameter was 1403 Hz, the speedometer reading is 
60 MPH and the indicated dyno speed is 57 MPH, then 
the new VSS frequency parameter should be: 

  1476 Hz  =  1403 Hz x 60 MPH                                 
               57 MPH 
 

The speed units cancel out, so you can use 
either MPH or KPH units in the calculation as long as 
you use the same units for both the speedometer 
reading and dyno speed. For best accuracy, use a test 
speed near highway cruising speed.   
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USER FUNCTIONS  
User functions are displayed in a dialog box by 

using the Edit User Functions command on the Edit 
menu. User functions control the operation of the user 
input and user output of the TCFI unit.  

The user input function is not available on TCFI 
IID units and all user input functions are grayed out. 

The user output on pin 22 can drive a small load 
up to 0.5 amps and is protected against short circuits. 
The user output is “active low.” It can be used to drive 
a standard automotive relay returned to +12V. When 
the user output is active, the pin is grounded. 

Figure 8 – User Functions Dialog Box 

 
 

User output functions include: 

Off – default mode.  

RPM And TPS Based Switch – general 
purpose switch function based on RPM and TPS. The 
user output is set on (pulled to ground) when RPM >= 
RPM On AND TPS >= TPS On. The user output then 
remains on until it is reset off when RPM < RPM Off 
OR TPS < TPS Off.   

NOS Trigger  – specifically designed to trigger 
an NOS system. The user output is set on (pulled to 
ground) when RPM >= RPM On AND TPS >= TPS On 
AND VSS >= Minimum VSS. The user output then 
remains on until it is reset off when RPM < RPM Off 
OR TPS < TPS Off OR VSS < Minimum VSS. As an 
additional safety feature to prevent engine damage, the 
user output is immediately tripped off if the RPM limit is 
exceeded and cannot be set back on again until the 
engine RPM drops below the RPM Off level. In NOS 

trigger mode, the user retard value (0 to 10 degrees) is 
applied whenever the user output is on. 

Once you have entered the appropriate user 
function parameters, click on OK to save your edits to 
buffer memory. If you click on Cancel, all your edits are 
lost. You can click on Restore Defaults to restore 
default values.  
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UPLOADING DATA 
Refer to the Downloading Data section on page 

2 for details about USB Interface or PC link cable 
hookup and COM port setup. Before uploading, make 
sure the module parameters are correct.   

Upload data by using the Upload Data To TCFI 
command on the Communications menu. A status 
message is displayed when the upload process has 
been successfully completed. 

If you attempt to upload data to anything other 
than a TCFI IID unit with correct firmware, an error 
message will appear and the upload will be aborted.  

TROUBLESHOOTING FLOWCHART 
Follow the troubleshooting flowchart shown 

below. Experience has shown that most 
communication problems are user error or PC 
compatibility issues. 

Troubleshooting Flowchart
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